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PD20713-L 

Inventor—Presenting in a New Fashion 
Jerry Berns 
4D Technologies, LLC 

 

Description 

The Inventor 2017 Presentation environment has had a major upgrade, and you need to get up 
to speed quickly on the interface tools to create your exploded views and animations. In this 
hands-on lab, users will discover the new Inventor 2017 Presentation environment and 
experience its new editing and publishing tools. Attend this class to learn how to create the 
presentations you could only dream of showing your clients before now! This session features 
Inventor Professional. 

Your AU Expert 

Jerry Berns is the Manufacturing Content Manager for all CADLearning manufacturing products 
from 4D Technologies, developing on-demand learning material for Autodesk Software users, 
including Inventor and Fusion 360. An Inventor Certified Professional and Autodesk Certified 
Instructor, he has amassed a wealth of expertise at engineering firms and Autodesk value 
added resellers (VARs) in the implementation, use and support of Autodesk products since 
1985. Jerry has worked at a number of Autodesk Resellers, where he worked with hundreds of 
clients, including several Fortune 100 companies. Jerry has presented several times at 
Autodesk University since 2006, earning a Top Rated Speaker in 2013. 

 

 

 

 
 

Learning Objectives 

 Explore the Inventor 2017 Presentation environment 

 Learn how to create storyboards and snapshot views for use in drawing views 

 Learn how to create actions to show others how to assemble or repair models 

 Learn how to publish presentations to share with downstream recipients 
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Inventor 2017 Presentation Environment 

The Inventor Presentation environment is used to create exploded views and animations of your 
Inventor assembly models. These views are used to show assembly instructions or reveal 
internal components. Animations can be developed to show assembly, disassembly, or 
maintenance operations. 

  

Interface 
The Presentation environment consists of five main elements; the ribbon, the graphics window, 
the Model browser, the Snapshot Views panel, and the Timeline. Each element can be 
positioned or adjusted to suit. 

 

Presentations contain scenes, which are independent of each other. They are associated to a 
source model and its model representations. 



 

 

Page 3 

Application Setup 
It will be necessary to set the Inventor project file to complete the exercises. 

1. Using Windows Explorer, browse to the folder: 

2. C:\Datasets\Lab02 San Polo 3403\PD20713-L 

3. Double-click PD20713-L.ipj to launch Inventor.  

4. Click Open to review workspace and frequently used folders. 

5. Press ESC. 

Exercise 1 
In this exercise, you will explore the interface elements of the presentation environment. 

1. In Inventor, select Open. Browse to the folder Designs\Bevel Gear. 

2. Open the presentation named Bevel_Gear_01.ipn. 

 

3. Activate Explosion1 scene and then Play the current storyboard. 

 Which is the first component to be disassembled? ____________________ 
 Which is the last component to be disassembled? ____________________ 

4. Activate Explosion2 scene. 

 How many storyboards are contained in this scene? _____ 

5.  Play the first storyboard. 

 Which component is simultaneously moved and rotated? _______________ 

6. Activate Explosion1 scene. 

 How many snapshot views does this scene contain? _____ 

7. Close the file. No save required. 
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Exercise 2 
In this exercise, you will explore two methods of creating a presentation. The first method uses 
the Home Page. 

1. In Inventor, select Open. Browse to the folder Designs\Cylinder Clamp. 

2. Open the assembly named Cylinder_Clamp_01.iam. 

3. Explore the Design View Representations. Leave Master as active.  

4. On the Inventor Home Page, click Presentation. 

5. In the Insert dialog box, browse to the folder Designs\Cylinder Clamp. 

6. Select, but do not open, Cylinder_Clamp_01.iam. 

7. Click Options. 

8. Select the following File Open representation options: 

 Design View = Default (Associative) 

 Positional = Master 

 Level of Detail = Master 

 How many Positional Representations are available? _____ 

9. Click OK. 

10. Select Open. The model appears in the presentation. One scene and one storyboard have 
been created. 

 

11. In the Model browser, right-click Scene1. From the context menu, select Representations. 

NOTE: You can only modify the Design View and Associative status. 

12. Select Piston and then click OK. Note the visibility state changes. 

13. Close the file. No save required. 
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 The second presentation creation method, added in Inventor 2017 R2, uses the assembly 
context menu. 

1. Switch to the Cylinder_Clamp.iam document. 

2. Activate the following representations: 

 Design View Representation = CylinderBody 

 Position = Retract 

3. Right-click the top-level browser node. From the context menu, select Create Presentation. 

4. Select the default presentation template. 

In the graphics window, only the cylinder body is visible. Note the visibility states of the parts in 
Scene1. 

 

NOTE: Only the design view rep was input, not the positional rep. 

5. Close the file. No save required. 
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Scenes, Storyboards, and Snapshot Views 

Presentations contain scenes, which establish an associative link to an assembly. You can have 
multiple scenes within a presentation. Scenes can link to the same or different assemblies. A 
scene contains at least one storyboard. 

Storyboards store the actions you create to explode an assembly. Actions consist of moves and 
rotates, which transform the components into their disassembled positions. You can also create 
camera, visibility, and opacity actions. Your scene can contain multiple storyboards. 

New storyboards can be created as one of two types: “Clean” or “Start from end of previous”. 
Use the second method when you want a new storyboard to continue from the exploded state of 
another storyboard. However, the storyboards are not associated, so changes in one will not 
affect the other. 

Snapshot Views are a capture of the storyboard at a particular instant on the Timeline. A 
Snapshot can be independent of the storyboard or associated with it. If the storyboard changes, 
an associative snapshot view can be updated. You can use the Timeline Scratch Zone to easily 
build independent snapshot views. 

Once created, storyboards are used to publish animations. Snapshot Views are used to create 
drawing views, which can be essential to communicate assembly information. 

The following exercises will step you through the process of creating these elements. 

Exercise 3 
In this exercise, you will create the scenes for a presentation. 

1. On the Home Page, create a new Presentation. 

2. In the Insert dialog box, browse to the Designs\Ember\Data folder, and select Base 
Assembly.iam. Click Open. 

 

3. Right-click in the Model browser and select Create Scene. 

4. In the Insert dialog box, same folder as above, select Build Assembly.iam. Click Open. 

5. Repeat the process to create a scene for Case Assembly v16.iam. 

6. Double-click Scene1 to activate it. On the ribbon, select New Snapshot View. 

7. Repeat this process for Scene2 and Scene3. 
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Note the unique storyboard and snapshot view for each scene. 

8. Close the file. No save required. 

Now you will create a presentation with multiple scenes using the same assembly. 

9. Create a new presentation. 

10. In the Insert dialog box, browse to the Designs\Ember\Data folder, and select 
EMBER_Assembly.iam. Use Options to select Default View Representation, and then 
deselect Associative. Click OK and then Open. 

 

11. In the Model browser, expand Scene1 > EMBER_Assembly.iam. 

12. The playhead should be at 0.0 s in the Timeline. In the browser, toggle off the visibility of 
Build Assembly and Case Assembly v16. Create a snapshot view. 

13. To create a new scene using the same assembly, drag and drop Scene1 onto the top node 
in the browser. The scene and snapshot are copied. 

14. Expand Scene2 > EMBER_Assembly.iam. 

15. Toggle off the visibility of Base Assembly. Toggle on the visibility of Build Assembly. 

16. Delete the copied snapshot view. Zoom All the model, and then create a new snapshot 
view. 

17. Repeat the drag-and-drop process to create a third scene. 

18. Set Case Assembly v16 as the only visible subassembly. 

19. Delete the copied snapshot view and create a new one. 

20. Double-click a different scene to activate it. Review each scene. 

21. Close the file. No save required. 

Use the Create Scene command to select the same assembly or a different assembly. Use 
Options to select representations. Drag and drop a scene in the browser to create a quick copy 
of a scene to use the same assembly and representation. 

 TRUE or FALSE: When you drag and drop a scene in the browser onto the top node, 
you can choose the design view, positional, or level of detail representation. 
___________ 

 TRUE or FALSE: When you use the context menu to create a scene, you can choose 
the same or different assembly. ___________ 
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Exercise 4 
In this exercise, you will create the storyboards and snapshot views for a GearBox. 

1. Open from the GearBox folder, GearBox_01.ipn. 

 

2. Select the cover. Right-click and select Tweak Components. 

3. Move the cover vertically a distance of about 250 mm. Set the Duration = 1 s. Click OK. 

4. Zoom All and then use Capture Camera. 

5. From the ribbon or Marking menu, select New Snapshot View. Name the snapshot view, 
“Cover”. 

6. View the model from the front. Window select the shaft components on the left. Start Tweak 
Components. Set UCS = World, Trails = Single, and Duration = 1 s. 

7. Move the components vertically 125 mm. Click OK. 

8. Create a similar tweak for the shaft components on the right. Use a distance of 75 mm. 

9. Drag the playhead to 2 s or just after the left shaft component actions. Right-click the 
playhead and select New Snapshot View. Name the snapshot view, “Shaft1”. 

10. Create a snapshot view for the right shaft components. Name the view, “Shaft2”. 

 

Snapshot views can be created using the ribbon, marking menu, or the playhead context menu. 

11. From the ribbon, marking menu, or Timeline, select New Storyboard. 
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12. In the New Storyboard dialog box, select the Clean storyboard type and then click OK. 

This creates a storyboard with all components in their assembled positions. 

13. Click in the Scratch Zone to move the playhead there. 

14. Select the gearbox cover and case. Right-click and select Visibility. This hides these parts. 

15. Turn off the Visibility for the shaft components on the right. 

With the playhead in the Scratch Zone, no actions were recorded. 

16. Move the playhead to 1 s. Add tweaks to disassemble the shaft 1 parts. Add a snapshot 
view for the disassembled state. 

17. Activate Storyboard1. Start New Storyboard. For the type, select Start from end of 
previous. 

The storyboard has been inserted between storyboards 1 and 2. This can be useful to insert an 
instruction animation. 

NOTE: Storyboards currently cannot be renamed or reordered. 

18. Click in the Scratch Zone. Turn off the visibility of the cover, case, and shaft 1 components. 

19. Add tweaks to disassemble the components on shaft 2. Create a snapshot view at the end. 

20. Save as GearBox_Practice_02.ipn. Close the file. 

The snapshot views could now be used to create drawing views. 

 TRUE or FALSE: You can drag thumbnails in the Snapshot View panel to change the 
order. ___________ 

Exercise 5 
In this exercise, you will create associated and independent snapshot views. 

1. From the GearBox folder, open the file GearBox_02.ipn. 

2. In Storyboard1, drag the playhead to 1 s. Right-click the playhead and select New 
Snapshot View. 

An associated snapshot view is created, as indicated by the playhead on the snapshot view 
thumbnail. 
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3. Activate Storyboard2. Click in the Scratch Zone. Select New Snapshot View. 

Because the playhead was in the scratch zone, an independent snapshot view is created, as 
indicated by the absence of the playhead on the thumbnail. 

 

4. Activate Storyboard1. Click in the Scratch Zone. Hover the cursor over the view marker in 
the Timeline. The associative snapshot view name is displayed. Click the marker to see the 
thumbnail highlight in the Snapshot View panel. 

5. Move the playhead to 1 s. In the graphics window, double-click the trail for the 
GearBoxCover Move action. Change the distance to 225 mm. Click OK. 

The snapshot view now requires updating, as indicated by the update icon on the thumbnail. 

 

6. Right-click the thumbnail and select Update. 

The view is updated with the new component position.  

Next, you will update the independent view: 

7. Double-click the snapshot view named View2. Switch to a Top, Front, Left isometric view. 

8. On the ribbon or from the marking menu, select Update Camera. The thumbnail updates. 

9. Click Finish Edit View. 

10. Close the file. No save required. 

Both views could be used for drawing views. Use an associated snapshot view when you want 
to maintain a link between the view and changes in the model. 

 TRUE or FALSE: You can change an associative snapshot view to independent. 
___________ 

 TRUE or FALSE: You can change an independent snapshot view to associative. 
___________ 
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Create Actions 

Actions tell the story of how to assemble or disassemble the model. Actions can also be 
changes to the camera view, or to the visibility or opacity of a component. 

Tweak Components 
The Tweak Components command uses a mini-toolbar interface to select the transform type, 
selection type, UCS, triad positioning, trail style, trail customization, and duration. 

 

On the Timeline, tweaks are usually inserted after the position of the playhead. 

Camera 
Camera actions are created with the Capture Camera command. These are useful to change 
the viewpoint of the model to see components that were obscured or at a different 
magnification. They can be instant or duration type actions. 

On the Timeline, camera actions are usually inserted before the position of the playhead. The 
exception is when the playhead is at 0.0 on the Timeline. 

To update a camera action, move the playhead to the end of the action. Click Capture Camera. 

Visibility 
The Visibility Command, available on the context menu, toggles off the visibility of the selected 
components. The action is inserted at the playhead position. 

 

Opacity 
Opacity is an alternative visual action. You can choose a component’s level of opacity from 0 – 
100, with 100 being opaque and 0 being invisible. 
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After creating, you can edit the action to change to a Duration type. With Duration, you can 
specify the Start, Duration, or End time. 

  

Appearance 
Although not an action, it is worth mentioning here amongst the visual styles. The Quick Access 
Toolbar contains the Appearance menu. You can override the color or material appearance of 
selected components. 

The following exercises will explore the different actions you can create and how to edit them. 

Exercise 6 
In this exercise, you will create an exploded view for some of the parts in the Arbor Frame 
assembly. 

1. On the Inventor Home Page, click Presentation. 

2. In the Insert dialog box, browse to the folder Designs\Arbor Press. 

3. Select Arbor_Press_01.iam. 

4. Click Options. 

5. Select the following File Open representation options: 

 Design View = Master 

 Positional = Mid 

6. Click OK and then click Open. 

7. On the View tab, set the following: 

 Visual Style = Shaded with Edges 

 Lighting Style = Two Lights 

Optionally, you could also set the ViewCube Front and Home views. 

 

8. In the graphics window, select TABLE PLATE. Right-click and select Tweak Components. 
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Note the alignment of the tweak triad. 

9. In the mini-toolbar, change the UCS to World and Trail to Single. Ensure Duration = 2.5 s. 

10. Use the Z-axis arrow to drag the table plate up about 1 inch or enough to clear the 
GROOVE PIN. 

11. Use the Y-axis arrow to drag the table plate out a suitable distance. 

12. Now select the GROOVE PIN. 

Note the two Move actions created in the Timeline. 

13. Move the groove pin up and out in a similar manner as the table plate. Click OK. 

The Timeline contains four Move actions.  

14. Play the storyboard. The Move actions were created using the default duration time. 

15. Double-click the first Move action. In the dialog box, change Duration = 1 s. Click OK. 

  Editing each action duration individually would be time-consuming. R2 is enhanced with 
multiple action duration editing. 

16. On the Timeline, hold CTRL and select the other three actions. Right-click and select Edit 
Time. Change Duration = 1 s. Click OK. 

17. Drag the actions on the Timeline to eliminate the gaps. 

 

 

18. Click Forward to Storyboard End. 

Next, you will combine a Move and Rotate action: 

19. Orbit to view the left side of the model. Zoom near the COLLAR component. 
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20. Select ISO 4766 - M5 x 5. Right-click and select Tweak Components. 

21. With UCS = Local and Duration = 1 s, remove the set screw by dragging along the Z-axis a 
Distance = 1.6 mm. 

22. On the mini-toolbar, click Rotate. Drag the Z-axis grip in a counter-clockwise direction a 
short distance. Set Angle = 720°. Click OK. 

A combination action has been created. 

 

23. Drag the playhead before the action and then click Play. 

The set screw is moved and then rotated.  

Once you create actions, you can edit them to occur simultaneously: 

24. In the Timeline browser, expand ISO 4766 - M5 x 5. Drag the Rotate action so that its start 
time aligns with the Move action start time. A dashed line appears when start/end times are 
aligned. 

Before  After  

 

25. Click Forward to Storyboard End. 

26. CTRL select ISO 4766 - M5 x 5 and COLLAR. Start Tweak Components. 

27. Set UCS = World and then drag along the X-axis to remove the collar and set screw. DO 
NOT CLICK OK. Orbit the model to view the right side. 

28. In the mini-toolbar, change Trail Style = All Components. A trail is created for each part. 

29. Change Trail Style = Single to produce a single trail for the tweaked components. Click 
OK. 

30. Play the storyboard to review your progress. 

31. Save as Arbor_Press_Practice_01. 

32. Close the presentation. 

 TRUE or FALSE: You can only edit the duration for one action at a time. ___________ 
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Exercise 7 
In this exercise, you will edit actions and capture camera positions. 

1. From the Arbor Press folder, open Arbor_Press_02.ipn. This is a slightly altered version 
from the previous exercise. 

 

2. In the Timeline browser, expand ISO 4766 - M5 x 5. Referred to here as the set screw. 

The set screw Rotate action needs to align with its Move action. The subsequent actions need 
to shift left. 

3. Right-click the set screw Rotate action and select All After. 

  R2 introduced new action selection tools: All After, All Before, or Group (all members of a 
group tweak). 

4. Drag the Rotate action until it is aligned with the Move action for the set screw. 

 

5. Click ViewCube Home. 

6. Play the storyboard. 

It is easy to see the TABLE PLATE and GROOVE PIN actions, but the SET SCREW and 
COLLAR are obscured. Add camera actions to resolve. 

Now you can reposition the camera and capture camera actions to see the SET SCREW and 
COLLAR: 

7. Drag the playhead to the end time of the set screw’s Move/Rotate actions. (5 seconds) 

8. Orbit and zoom the model to see the SET SCREW and COLLAR. 

9. From the ribbon or context menu, select Capture Camera. The Camera action appears on 
the Timeline. Edit its Duration = 2 s. 

10. Use Select > All After to select the set screw Move action and all following actions. 
Deselect the Camera action if it is selected. Drag the selected actions so that the set screw 
Move action start time aligns with the Camera action end time. 
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11. Move the playhead to the storyboard end. Add another Camera action to return to the Home 
view. Edit the Camera action. Change Start Time = 8.5 s and Duration = 1.5 s. 

Additional actions could be added to continue the disassembly process. 

12. Play the storyboard. 

13. Close the file. No save required. 

 TRUE or FALSE: Using Select > All After will select actions and snapshot view markers 
on the Timeline. ___________ 

Exercise 8 
In this exercise, you will insert actions, grip edit actions, and update camera positions. 

1. Open from the Pump Reservoir folder, Pump_Reservoir_01.ipn. 

Fasteners, added after the presentation was created, need to be exploded. 

 

2. Drag the playhead to 0 s on the Timeline. Use Tweak Components to move the fasteners 
up about 100 mm. 

3. Drag the playhead to 1 s on the Timeline. Zoom All. Click Capture Camera to update the 
current camera action. 

4. Play the storyboard. 

5. On the Timeline, drag the actions for the CAP, GASKET, and COLLARS to occur after the 
fasteners have moved. 

6. Drag the snapshot view markers on the Timeline to advance each one by 1 second. 
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7. Drag the playhead to 2 s. Hover the cursor over the center of the CAP. When the trail origin 
grip appears, click and drag it to reposition the CAP near the fasteners. Update the 
snapshot view. 

 

8. Drag the playhead to 3 s. Use the trail origin to drag the GASKET. Update the snapshot 
view. 

9. Repeat the process for the COLLARS. 

10. In the browser, expand the Scene1 > Tweaks folder. Review the tweak distances. Click a 
tweak to edit the value. 

11. Close the file. No save required. 

 TRUE or FALSE: Inserting a tweak between actions automatically moves the other 
actions on the Timeline. ___________ 

Exercise 9 
In this exercise, you will edit actions, capture camera positions, and create storyboards. 

1. Open from the Arbor Press folder, Arbor_Press_03.ipn. 

 

2. Right-click the first Camera action and select All After. Drag the selected actions near 18 
seconds on the Timeline to allow room to insert other actions. 

3. Drag the playhead 1 second past the last GROOVE PIN Move action. Zoom to the FACE 
PLATE part. 

4. Right-click a Socket Head Cap Screw (SHCS) and select Tweak Components. Set UCS = 
World, Trails = All Components, and Duration = 1 s. Drag the SHCS away about 9 
inches. 

5. In the mini-toolbar, click Add/Remove Components. Now select the other three SHCS 
holding the FACE PLATE. Click OK. 

Use Add/Remove Components to change the selection set while creating the tweak. 
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6. Zoom as needed to see the disassembled SHCS and the FACE PLATE. Click Capture 
Camera. 

7. Use Tweak Components to remove the FACE PLATE about 4.5 inches. Click OK. 

8. To add the Socket Head Set Screws (SHSS) to the FACE PLATE Move action, double-click 
the trail of the FACE PLATE. The part highlights to ensure correct selection. Hold CTRL and 
then select the two SHSS. They are moved to the FACE PLATE position. Click OK. 

9. Create a tweak to remove the SHSS from the FACE PLATE. Move them away about 2 
inches. 

10. Create a tweak to remove the GIB PLATE, and then another to move the RAM. 

11. Rewind and play the storyboard. 

  R2 introduces the ability to drag actions before or after other actions on the Timeline. 

12. On the Timeline, locate the Move actions for the ISO 4026 M5 x 16 parts. Drag the last 
Move actions before the first Move actions. Drag the actions to reposition their start times. 

Before  After  

13. Rewind and play the storyboard. 

14. Drag the second camera action so that it occurs after the RAM move. 

15. Drag the actions for the ISO 4766 and COLLAR so that they occur after the second camera 
action. Drag the last camera action to align its end with the COLLAR action end. 

16. Drag the playhead to the end. Start Tweak Components. In the mini-toolbar, change 
Selection Type to Part. Select the LEVER ARM. 

Use Selection Type to determine whether parts or subassemblies are selected. 

17. Change Selection Type to Components. Pick the LEVER ARM again and the entire 
subassembly is selected now. 

18. Drag the HANDLE ASSEMBLY away about 12 inches. 

19. In the mini-toolbar, change Trail Style to All Parts. The number of trails increases. Change 
Trail Style to Single. Now only one trail is visible. Click OK. 

20. Add a tweak to remove the remaining SHSS on the left side of the frame. You may wish to 
include a camera action. 

Now a storyboard can be created just for the handle assembly. 

21. Close the file. No save required. 

Exercise 10 
In this exercise, you will add and edit visibility and opacity actions. 

1. Open from the Arbor Press folder, Arbor_Press_04.ipn. 
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2. Create a New Storyboard using the Clean type. 

3. Drag the playhead to 2 s on the Timeline. Use the browser to select all the parts except the 
HANDLE ASSEMBLY. Right-click and select Visibility. Visibility actions are added to the 
Timeline. 

4. Scrub the playhead from start to end to see the parts immediately become hidden. 

5. Click Undo to remove the Visibility actions. 

6. With the playhead at 2 s, select the parts again except for the HANDLE ASSEMBLY. Right-
click and select Opacity. Set the Level = 50 and then click OK. 

7. Scrub the playhead from start to end to see the parts immediately fade at 2 s. 

8. To change the fade timing, Use Select > All After on the first Opacity action in the Timeline. 
Hover the cursor over the left edge of the action. When you see a double-arrow cursor, click 
and drag to change the Instant type action to a Duration type action. Drag to 0.1 s. Scrub 
the playhead to see the effect. 

Opacity actions cannot start at 0 seconds. Use 0.1 instead. 

9. Select all of the Opacity actions. Drag the start times to 1 s. 

10. Scrub the playhead to see the effect of the Opacity action duration setting. 

11. Select all of the Opacity actions again. Right-click and select Edit Opacity. Change Level = 
0. Click OK. 

12. Scrub the playhead to see the edited effect. Now the components completely disappear. 

13. Drag the playhead 1 second past the opacity actions. Use the ViewCube to view the model 
from the RIGHT. 

14. Window select all of the handle assembly parts, and then start Tweak Components. In the 
mini-toolbar, select Rotate. Drag the handle so that it is nearly level. Set Trails = No Trail 
and Duration = 1 s. Click OK. 

15. Return to an isometric view. No need to capture any camera changes. 

16. Move the playhead 1 second past the last action. 

This gives time for the view to settle before more actions occur. 

17. Start Tweak Components. Change Trails to All Components. Add a Move tweak to 
remove a HANDLE CAP. Add another tweak to remove the second HANDLE CAP. Drag the 
second HANDLE CAP to the left to make room for the handle. 

18. Adjust the Move actions so that the HANDLE CAPS remove simultaneously. 

19. Add a Move action to remove the THUMB SCREW. 

20. Now add a Move action to remove the LEVER ARM from the PINION SHAFT 

21. Rewind and play the storyboard. 

22. Click Forward to Storyboard End. 

23. Click Reverse Play All Storyboards to see the model assemble. 

24. Close the file. No save required. 
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Exercise 11 
Presentation trails represent the distance or angular paths that components follow to their 
disassembled position. In exploded assembly views, trails can provide clarity as to the intended 
assembled location. Inventor provides controls to manage the trails during tweak creation and 
for editing after the action has been created. 

In this exercise, you will use the various options to create trails for a simplified version of a 
FIRST Robotics Competition design. 

1. From the FRC Robot folder, open FRC_Robot_01.ipn. 

 

2. In the Model browser, expand the scene and then expand the assembly and subassemblies. 
The model contains a number of subassemblies. 

3. Start Tweak Components. On the mini-toolbar, set Selection = Components and Trails = 
All Components. Hold CTRL, and then select the wheel assemblies on the right side of the 
robot. Set the tweak type to Move. 

4. Parallel to the axle, drag the wheels about 300 mm away from the frame. Two trail lines 
appear, one for each subassembly. 

5. In the mini-toolbar, set Trails = All Parts. Every part in all of the subassemblies receives a 
trail line. 

6. Change Trails = Single. Now, only a single trail is created for all of the components. The 
trail is assigned to the first selected component in the tweak. 

7. Change Trails = All Components. Click OK. 

8. In the graphics window, double-click one of the trails and a mini-toolbar appears. Change 
Trails to another method and note the difference. Click Cancel. 

9. Select one of the trails again. Click and drag the trail end manipulator. All components 
participating in the tweak will be adjusted. 

Next, you will remove the battery. 

10. Zoom in the near the back of the robot and capture the camera action. Be sure the action 
occurs after the previous tweak. 

11. Tweak the battery up a distance of about 250 mm, but do not select OK yet. 

The battery has two alignment pins which seat into the holes of the bottom guard. Use the mini-
toolbar to change the trails. 

12. Change Trails = No Trail and then select Add New Trails. Orbit the model so that you can 
pick the bottom faces of the battery alignment pins. Click OK. 

Two trails now help to communicate how to place the battery. 
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13. To return to the previous camera view, drag the playhead over the last camera action. With 
the view restored, move the playhead about 1 second past the last action. Use Zoom All 
followed by Capture Camera. 

By default, Full Trails are applied to components when the trails are created. Next, you will 
explore the segment trail option. For some tweaks, it may not be necessary to record all the 
paths, so you may want to show only some segments. 

14. Start Tweak Components, and then select a Gusset. Change Trails = No Trail and the 
Trail Type = Trail Segments. Tweak the gusset up about 200 mm. 

15. Click Add New Trails. Pick the centers for the two outer holes on the straight portion and 
the middle hole of the leg. You may need to orbit the model slightly to see the three paths. 
Click OK. 

16. Close the file. No save required. 

 On the Tweak Components mini-toolbar, what button allows you to create custom trails? 
____________________ 

 

Exercise 12 
In this exercise, you will discover how to edit trail visibility and start positions. Trails are erased 
when a tweak is deleted.  

1. From the FRC Robot folder, open FRC_Robot_02.ipn. 

2. Start Tweak Components and then select a gusset that is still in its assembled position. 
Using All Parts and Full Trail, tweak the part up, then forward, and then to the left. Click 
OK. 

A tweak with a visible trail has been created for each movement. 

3. Select and then right-click one of the trail segments. Select HIDE TRAIL SEGMENT > 
Current to hide just that segment. Now select and right-click the gusset. From the context 
menu, select Hide Full Trail. All the segments disappear. 

4. In the Model browser, expand the Tweak folder as needed and scroll to the bottom. Notice 
the appearance of the tweaks that have the trails hidden. 

5. Select one of the hidden trails and right-click. Select Show Trails. That segment is restored. 

6. In the graphics window, right-click the gusset and select Hide Full Trail. Right-click it again 
and select Show Full Trail. All the trails are restored. 

If you delete a tweak, its trail is also deleted. However, you can control the level of deletion 
based on the trail that was created. 
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7. The drive assemblies were tweaked simultaneously as components. Select one of the trails, 
and then right-click and select Delete Tweak > Current. Notice that only one tweak and trail 
were deleted. Use Undo to restore the tweak. Select and right-click the trail again. This time, 
select Delete Tweak > Group. Both assemblies move to their original positions. 

8. Close the file. No save required. 

Publish Presentations 

Image 
Assembly instructions, whether printed or digital, are still quite common in this video age. You 
can create raster images for use in these publications using the Raster command. 

Exercise 13 
In this exercise, you will create raster images from snapshot views. 

1. Open from the Bevel Gear folder, Bevel_Gear_02.ipn. 

 

2. In the Snapshot Views panel, click in an empty space to deselect any views. 

3. On the ribbon, Publish panel, select Raster. 

4. In the Publish to Raster Images dialog box, Scope group, All Views is the only choice. 

5. In the Image Resolution group, select 1280 x 720. 

6. In the Output group, the File Name is based on the Scope selection. Expand the File 
Format drop-down and select PNG. Click OK. 

The graphics window will change as each snapshot view is activated to create the raster image. 
When the screen stops changing, the images have been created. 

  Publishing images with a transparent background is now available. 

7. Use Windows Explorer to browse to the output folder location. Review the images.  

8. Return to the presentation. 

9. Hold CTRL and select any two snapshot views. Right-click and select Publish to Raster. 
Now only the selected views would be published. Click Cancel. 

You can also publish a custom raster view. 
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10. Double-click the view named Step6. Zoom closer to the model and center in the graphics 
window as needed. Right-click and from the Marking menu, select Raster. This time the 
Scope is set to Current View. Click Cancel to close the dialog and then click Finish Edit 
View either from the ribbon or Marking menu. 

11. Close the file. No save required. 

 

Video 
Assembly instructions can often be made more clear when a video shows the assembly 
process. 

Exercise 14 
In this lesson, you will explore your storyboard publishing options.  

1. From the Bevel Gear folder, open Bevel_Gear_02.ipn . 

2. On the Storyboard panel, select Storyboard1. On the ribbon, Publish panel, select Video. 

3. In the Publish to Video dialog box, Scope group, select the Current Storyboard option. 

Note the file name in the Output group. 

4. Now select the All Storyboards option. Inventor updates the file name based on the Scope 
selection. Select the Reverse option. 

5. In the Video Resolution group, select the 800 x 600 resolution. 

Be aware that if you develop your animations using a widescreen format such as a 16:9 ratio, 
and then publish to a 4:3 format, portions of the screen will be cropped.  

6. In the Output group, type the name, “Bevel_Gear_Assembly”. Select WMV from the File 
Format menu. 

7. Click OK to publish the video. 

The dialog box closes, and the Publish Video Progress dialog box appears. The storyboards are 
played as the video is created. You can select Cancel if you notice an issue while the video is 
being created. Once the video is published, a notification message will appear. 

8. Using Windows Explorer, browse to the video folder location. Select and open the video. 

If you prefer, you could publish the storyboards as separate videos. Users could select a 
specific assembly task to watch. This would make it easier than navigating through a large 
video. 

9. Close the file. No save required 

 How many snapshot views can be created in a scene? ____________________ 
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Drawings 
Once you have created your presentation, you can document it in drawing views. The drawing 
views are based on the snapshot views in your presentation. 

In this lesson, you will create a drawing of the assembly and two snapshot views in the 
presentation. You will use the Slide Tool assembly. 

Exercise 15 
In this exercise, you will create drawing views from snapshot views. 

1. From the Slide Tool folder, open Slide_Tool_10.ipn. 

 

2. In the browser, expand the scene named Full Assembly. Select and right-click 
Slide_Tool_10.iam. From the context menu, select Open. 

3. In the browser, right-click the assembly and select Create Drawing View. 

4. In the Drawing Template dialog box, double-click Standard.dwg. 

5. Select the ViewCube FRONT face. 

6. Set view Style to Hidden Line Removed and Shaded. Set view Scale = 1:1. 

7. Drag the front view to position it on the sheet towards the lower-left corner. 

8. Create the top, right, and isometric projected views. Click OK. 

Company standards vary when it comes to presentation drawings. Some companies prefer a 
single drawing with multiple sheets containing the assembled and exploded views, while other 
companies prefer separate drawings. The latter will be the direction for this lesson. 

9. Return to the Slide_Tool_10.ipn presentation file. In the Snapshot Views browser, right-
click the Disassembled snapshot view and select Create Drawing View. 

10. Double-click Standard.dwg in the Drawing Template dialog box. 

11. In the Drawing View dialog box, enable the Associative link option. The drawing view 
should be based on the scene named Full Assembly and the snapshot view named 
Disassembled. You could use the drop-down menu to select an alternate scene/view. Set 
Style to Hidden Line Removed and Shaded. Set Scale = 1:1. Select the option to Show 
Trails. 

12. Click OK. 
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13. Right-click the presentation view and select Open from the context menu. The associated 
model becomes the active document. Double-click the trail of the first, green, square head 
screw. Change the tweak distance to 140 mm. Click OK. 

14. Update the Disassembled snapshot view. 

15. Return to the presentation drawing. Since you marked the drawing view as associative to 
the presentation snapshot view, the changes you made in the presentation are updated in 
the drawing. 

16. To document the second snapshot view, right-click in the drawing browser and select New 
Sheet. Start the Base View command. 

This workflow is required since creating the drawing view from the presentation would start a 
new drawing, which is not desired in this case. 

17. In the Drawing View dialog box, ensure Slide_Tool_10.ipn is the selected file. For the 
Presentation view, select Handle Assembly : Step6. Enable the Associative and Show 
Trails options, as well as the Shaded view type. Scale the view to suit, and then drag it to 
center it on the sheet. 

18. Click OK. 

19. Close the file. No save required. 

 TRUE or FALSE: You must update the snapshot view in order for the associative 
drawing view to also update. ___________ 

 

BONUS NOTES: 

 Browser Folders are useful in assemblies, but are not visible in presentations 

 2017 R2 allows you to create a presentation from the assembly environment, but you do 
not get to choose initial representation. 

 2017 adds the ability to create staggered start times of actions. 

 Use the Action context menu to align start times or end times of actions. 


